
 

 

 

 

The Concept System
 

Software Guide 

Version 4.0 

 
 

 

 

 

 
1996, 2002, 2011 Concept Systems Incorporated 

All rights reserved. No portion of this manual may be reproduced without prior 
written permission from Concept Systems Incorporated, Ithaca, New York 

 
www.conceptsystems.com  • 607-272-1206 

 

http://www.conceptsystems.com/


 
The Concept System® Software Guide, v4.0.175           ii 

 

 

 

 

 

 

 

 

 

 

 

 



 
The Concept System® Software Guide, v4.0.175           iii 

TABLE OF CONTENTS 

The Concept System® Help ...................................................................................... 1 

The Installation Process .......................................................................................... 3 

Licensing and Installing .................................................................................................... 3 
The Concept System Non-Profit Planning Example Project .............................. 4 

1.  Prepare Project ...................................................................................................... 5 

Starting a New Project ....................................................................................................... 5 
Unlock Code ........................................................................................................................... 5 
Starting and Logging on .................................................................................................... 7 
Project Check In/Out .......................................................................................................... 8 
Setup Wizard ...................................................................................................................... 10 

(Admin-->Setup Wizard) .......................................................................................... 10 
File Menu .............................................................................................................................. 11 
Project Menu ....................................................................................................................... 11 
Admin Menu ........................................................................................................................ 12 
View Menu ........................................................................................................................... 12 
Help Menu ............................................................................................................................ 13 
Enter Focus Statement ................................................................................................... 13 

(Project-->Create Focus Statement) .................................................................... 13 
Create Users ........................................................................................................................ 13 

(Project-->Create Users) ........................................................................................... 13 
Create Participant Questions ....................................................................................... 15 

(Project-->Set Participant Questions) ................................................................. 15 
Set Rating Question and Scale Information ........................................................... 17 

(Project-->Set Rating Scale) .................................................................................... 17 
Assign Sorts and Ratings to Users ............................................................................. 19 

(Project-->Assign Sorts ............................................................................................. 19 
Exiting The Concept System® ...................................................................................... 21 

2.  Generate Ideas ..................................................................................................... 22 

Admin Menu ........................................................................................................................ 22 
(Admin-->Enter Statements) .................................................................................. 22 

Import/Export Statements ........................................................................................... 23 
(Admin-->Enter Statements) .................................................................................. 23 

Lock/Unlock Statements ............................................................................................... 24 



 
The Concept System® Software Guide, v4.0.175           iv 

(Admin-->Enter Statements)  From the Statements Screen select 
(Statements Menu-->Lock/Unlock Statements). ............................................ 24 

Enter/Edit User Contact Info ....................................................................................... 25 
(Admin-->Enter User Data) ..................................................................................... 25 

Enter/Edit User Demographics  (Participant Questions) ................................ 25 
(Admin-->Enter User Data) ..................................................................................... 25 

3. Structure Ideas ................................................................................................. 27 

Enter Sorts from Cards ................................................................................................... 27 
(Admin-->Enter User Data-->Manual Sort) ...................................................... 27 

Complete Sort ..................................................................................................................... 29 
Enter Ratings ...................................................................................................................... 30 

(Admin-->Enter User Data) ..................................................................................... 30 
Complete Rating ................................................................................................................ 32 

(Admin-->Enter User Data) ..................................................................................... 32 

4.  Prepare Maps ........................................................................................................ 33 

Mapping Menu ................................................................................................................... 33 
Select Sorts for Mapping ................................................................................................ 33 

(Admin-->Prepare Maps) ......................................................................................... 33 
Select Mapping Options ................................................................................................. 35 

(Admin-->Prepare Maps) ......................................................................................... 35 
Run Map Analysis ............................................................................................................. 36 

5.  Create and Interpret Maps .............................................................................. 37 

Create Map ........................................................................................................................... 37 
(View-->Concept Maps) ............................................................................................ 37 

Select Rating Information for Map ............................................................................ 37 
(View-->Concept Maps) ............................................................................................ 37 

Select Number of Clusters ............................................................................................. 38 
(View-->Concept Maps) ............................................................................................ 38 

Save Map .............................................................................................................................. 41 
Copy Map (Print) .............................................................................................................. 42 

(Mapping-->Draw Map) ............................................................................................ 42 
Load Map .............................................................................................................................. 43 

(View-->Concept Maps) ............................................................................................ 43 
Interact with Map ............................................................................................................. 43 

(View-->Concept Maps-->Click Draw Map) ...................................................... 43 
Moving a Statement from One Cluster to Another.............................................. 44 



 
The Concept System® Software Guide, v4.0.175           v 

Changing the Name of a Cluster.................................................................................. 45 

6.  Utilize Maps ........................................................................................................... 47 

Matching Menu .................................................................................................................. 47 
Create Pattern Match ...................................................................................................... 47 

(View-->Pattern Match) ............................................................................................ 47 
Select Rating Information for Pattern Match ........................................................ 47 

(View-->Pattern Match) ............................................................................................ 47 
Set Pattern Matching Specifications ......................................................................... 48 

(View-->Pattern Match) ............................................................................................ 48 
Save Pattern Match .......................................................................................................... 49 

(Pattern Matches & Go-Zones -->Draw Pattern Match) .............................. 49 
Copy Pattern Match (Print) .......................................................................................... 50 

(Pattern Matches & Go-Zones-->Draw Pattern Match) ............................... 50 
Load Pattern Match .......................................................................................................... 50 

(View-->Pattern Match) ............................................................................................ 50 
Create Go-Zone .................................................................................................................. 51 

(View-->Go-Zone) ........................................................................................................ 51 
Select Rating Information for Go-Zones .................................................................. 52 

(View-->Go-Zone) ........................................................................................................ 52 
Set Go-Zone Specifications ........................................................................................... 52 

(View-->Go-Zone) ........................................................................................................ 52 
File Menu of a Displayed Go-Zone ............................................................................. 54 
Save Go-Zone ...................................................................................................................... 54 

(Pattern Matches & Go-Zones-->Draw Go-Zone) ........................................... 54 
Copy or Print a Go-Zone ................................................................................................. 55 

(Pattern Matches & Go-Zones-->Draw Go-Zone) ........................................... 55 
To Exit the Graph: ............................................................................................................. 56 
From the Displayed Go-Zone window, select File then Exit Graphs. .......... 56 
Load Go-Zone ..................................................................................................................... 56 

(View-->Go-Zone) ........................................................................................................ 56 

7. Reports ................................................................................................................ 58 

8. Project Log Menu ............................................................................................. 62 

(View-->Project Log) .................................................................................................. 62 
 
 
 



 
The Concept System® Software Guide, v4.0.175           vi 

TABLE OF FIGURES   
 
Figure 1.  Example of the Concept System Help Main Screen ................................ 2 
Figure 2. Example of the Concept System Create Project Screen ......................... 6 
Figure 3:  Example of the Project list Screen ................................................................ 8 
Figure 4. Example of the Create Users screen ........................................................... 14 
Figure 5.  Example of the User Demographics screen ............................................ 15 
Figure 6.  Example of a Create Ratings screen .......................................................... 18 
Figure 7.  Example of an Assign Sorts screen ............................................................ 19 
Figure 8.  Example of an Assign Ratings screen ........................................................ 20 
Figure 9.  Example of the Statements Window ......................................................... 22 
Figure 10.  Example of Sort for User screen ............................................................... 28 
Figure 11. Example of the Enter Ratings Screen ...................................................... 31 
Figure 12. Example of the Prepare Map Window .................................................... 35 
Figure 13.  Example of Draw Maps Specifications screen .................................... 39 
Figure 14 .  Example of right mouse click options. .................................................. 44 
Figure 15.  Example of Pattern Matching Specifications Screen ....................... 49 
Figure 16.  Example of a Pattern Match ....................................................................... 51 
Figure 17.  Example of Go-Zone Specifications Screen .......................................... 54 
Figure 18.  Example of a Go-Zone. .................................................................................. 57 
Figure 19.  Example of the Choose Reports Tab in the Reports window ....... 58 
Figure 20.  Example of the Project Log Window ...................................................... 62 
 
 
 
 
 
 
 
 
 

 
 
 
 



 
The Concept System® Software Guide, v4.0.175           vii 

 
 
 



 
The Concept System® Software Guide, v4.0.175           1 

The Concept System® Help 
 
 

The Concept System® comes with an extensive context-
sensitive help system.  Whenever you are within the program, 
you can press the F1-key, go to the Help menu, or click the 
Guide button to obtain relevant help information.  The help          

system is divided into 3 major tabbed areas:   
 
Contents Tab  

Provides a basic Concept Mapping Overview as well as a listing of 
the major help areas covered.   

  
Index Tab   

From the Index Tab, you can type in a keyword, scroll down to the 
appropriate menu, or click on the Menu options and select Display.  
The system will display a listing of topics under the main category 
heading.  Click on Display to view information about the desired 
topic.   

 
Search Tab   

Allows you to search for specific help requests by typing in a search 
keyword.   

    Use the check boxes at the bottom of the screen to Search 
previous results, Match similar words, or to search titles of 
help documents only.   
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Figure 1.  Example of the Concept System Help Main Screen.  The Index Tab is currently 

selected in this example.   
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The Installation Process 
 

Licensing and Installing  

If you have questions about licensing, installing the program, 
obtaining new projects, concept mapping facilitator training, 
or technical assistance, please contact Concept Systems, Inc. 
directly.  (Telephone:  607-272-1206, Toll-Free:  1-800-260-

1602; Email:  csiinfo@conceptsystems.com)   
 
The Concept Systems Core© Software v4 may be downloaded from the 
Concept Systems website at: 
http://www.conceptsystems.com/content/view/the-concept-system.html.  
Please note that the Core Software is compatible with Windows XP, Vista, 
and 7 only.  When the installation begins, users will be prompted to enter 
information at various steps along the way.  It is recommended that users 
select the previously established defaults throughout the entire installation 
process. 

1. Exit all running applications on your computer, including the 
Microsoft toolbar if it is showing at the top of your screen. 

2. Click the link on the download page to begin downloading the CS 
Core Software©.   

3. Choose ‘run’ [in Internet Explorer] or ‘save to disk’ [in Firefox].  
Double click on the installer file in the Downloads window in Mozilla 
Firefox.   

4. Continue to follow the instructions on the webpage to complete the 
installation of The Concept System© V4. 

5. Once you have completed the installation process, open The Concept 
System® and check-in the Non Profit Planning example to the Project 
List to evaluate or practice using the software.   

 

You will need to download and install The Concept System® onto each 
computer you plan to use to run the program.   

 

mailto:csiinfo@conceptsystems.com
http://www.conceptsystems.com/content/view/the-concept-system.html
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The Concept System Non-Profit Planning Example 
Project   

The Concept System® comes with a Non-Profit Planning example project as 
well as an extensive on-line Help system.  You can immediately begin to use 
The Concept System® with the Non-Profit Planning example.    
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1.  Prepare Project 
 

Starting a New Project   

      Unlock Code  

Once you have installed the software, and are ready to 
activate the program to create your own concept 
mapping project, you will need to register with Concept 
Systems, Inc. (CSI) and purchase an unlock code to gain 
access to your single-use project license.  There are 
several licensing options available.  (Please see the CSI 

Pricing & Services Guide for details).   
 
To obtain a project license, please call (607) 272-1206 or toll-free:  1-800-
260-1602; fax (607) 272-1215; e-mail to csiinfo@conceptsystems.com; or 
write to CSI and provide the required project and billing information on our 
license registration form.  Once CSI has received all of the necessary 
documentation for the purchasing process and an acceptable form of 
payment, a staff member will then provide you with an unlock code to 
activate your project license.   

1. To begin a new project, open The Concept System® and click 
“New.”   

2. The system will generate a window providing you with a Code 
Entry Number and will request the corresponding Unlock Code.   

3. Contact CSI.  CSI staff will ask for your name and/or the name of 
your organization.  State that you would like to register for a New 
Project.  Payment, or a purchase order, will be necessary prior to 
obtaining your project license. Our office accepts Visa or 
MasterCard credit cards.  The CSI staff member will also ask you to 
fill out a License Registration Form, which will provide the basic 
details about your project to ensure that you are receiving the 
most appropriate license for your work.  Present the Code Entry 
Number, license registration form, and payment information to 
your CSI Staff Contact.   
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4. CSI staff representative will provide you with the Unlock Code.  
Enter the code into the Unlock Code box and click the Unlock 
Button.  Your new project is now Unlocked.   

5. You will be prompted to enter your project and administrator 
information.  Enter your project name, which will be displayed in 
the project list every time you open The Concept System®.  Enter 
your username and password.  The remaining fields are optional.   

6. Once you have entered the required information click Create.   

 

 

Figure 2. Example of the Concept System Create Project Screen. 

 



 
The Concept System® Software Guide, v4.0.175           7 

7. The Concept System® will ask you to navigate to the location where 
you would like to save your project database.  Select the Save 
button.  Please note where you save your database.  If you choose 
to save your database to the default location, it will be located in 
C:/Program Files (or Program Files (x86) on 64-bit 
machines)/Common Files/Concept System.  CSI recommends that 
you save the project database to a known and easily accessible 
location such as your Desktop or My Documents folder.  Do not 
save your database to the default location in Windows Vista or 
7.   

8. The Concept System will load your new project.    

Starting and Logging on 

The Concept System® program can be started by double-clicking on the 
program icon “The Concept System®” or by going to the Start menu>All 
Programs>Concept Systems>The Concept System®. 
 
The Concept System® logon screen provides a list of projects that are 
currently available to the program.  To login to a project, simply click on the 
name of the project and click OK.   
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Figure 3:  Example of the Project list Screen. 
 

Enter your Username and Password exactly as you created them.  Click OK, 
or press Enter, and The Concept System® Main Screen will appear.   

 

Project Check In/Out 

There is one menu on the Project List Screen:  the Project Menu. This allows 
you to Check In or Check Out an entire project so that you can move 
projects from machine to machine, or remove projects from the login list 
when you no longer need them.   
 
Check In allows you to add a project to the project list.  From the Project 
Menu on The Concept System® project list screen, select Project Check-In to 
make the project available.  The program will display a standard Windows 
file dialog box that allows you to browse for the project file.  Look for the 
.mdb file for the project you wish to check-in. 

1. When you have identified the project file, you will be shown the 
standard User Login Information screen and you must supply your 
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Username and Password.  When you have successfully checked the 
project in, it will be added to your project menu on the login screen. 
 
 Only persons with Administrator status are able to check 

projects into or out of the system. 
 The Administrator is responsible for deciding where the project 

file will be saved.  The Concept System® will always look for 
the project file in the location you specify when you check it 
in.  Be sure to place the project file where you want to keep it 
before you check it in. In general, you should not check a project 
in from a CD or USB device. Doing so, will necessitate you to 
supply the CD or USB device every time you log on to the project. 
Also note that not all components of your project database may 
function properly if you are running the database from a CD or 
USB device.  Using File Manager, copy the project file database to 
the desired drive and directory on your computer.  If you are 
using The Concept System® from a networked file server and 
wish to store the project file on the server drive, you will need to 
have permission to do so.  Check with your network 
administrator if you have any questions about where or how to 
install the file. 

 
Check Out allows you to move a project between computers that have The 
Concept System® installed.  For instance, you might need to move a project 
from your desktop machine to a laptop to take the project with you to a 
meeting.  Or, if you have a project that is no longer active, or that you wish to 
remove, you could use this option to check it out of the system first. 
Checking the project out simply removes it from the list of active projects 
that show up on the login screen.  It does not move, copy, or delete any file 
from your file manager.  After check out, the project is no longer available to 
any users from that location. 
You can undo the effect of checking a project out simply by checking the 
project back into the Concept System.   
 

1. Click on the name of the project and choose the Check Out option on 
the Project Menu to remove the project from the list on the login 
screen.   

2. You will be shown the standard User Login Information screen and 
you must supply your Username and Password.  The program will 
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issue a message showing the location of the project file.  You should 
write this information down so that you can find the file later.    

 
 Only persons with Administrator status are able to check 

projects out of the system. 
 The Administrator is responsible for managing the project file 

itself.  If the software is uninstalled, The Concept System® 
will never delete a project file; it only removes it from the 
list of currently active projects.  If you want to delete the 
project entirely, you must use the Windows operating system to 
do so, once you have checked the project out.   

 If you are moving the project to another machine, you should 
first check it out (as described above), and then use the standard 
Windows procedures for copying the project file to another 
machine.  Be sure to always check your project out of the 
current system before moving or deleting the project file 
itself.   

 If you are using The Concept System® from a networked file 
server and wish to check out the file to take it elsewhere, you 
will need to have network permission to do so.  Check with your 
network administrator if you have any questions about where or 
how to access the project file.   

 

Setup Wizard 

(Admin-->Setup Wizard) 

 
The setup wizard is provided to guide the administrator through the first 
steps of setting up a project. 
To access the wizard, click the Setup Wizard button at the top of the screen, 
or go to the Admin Menu and select Setup Wizard.  The wizard will help you 
start inputting your focus prompt, participant questions, rating questions 
and scales, and participants.  You can access the setup wizard at any time.   
  
The setup wizard allows you to do the following:   

1. Enter the focus statement.   
2. Define participant questions.   
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3. Enter the users who will participate in the concept mapping process.   
4. Assign users to sort.   
5. Create rating scales.   
6. Assign users to rating scale(s). 

 
To navigate the setup wizard:  

 Use the Next and Back buttons to move from one step to another. 
 To do one of the steps, click on the Launch button. 
 When you have completed all of the steps, click the Done button. 

 

File Menu 

The File menu gives you several options relating to printing, exporting, and 
accessing other projects.  Specifically, these options include:   

 Open another Project:  Takes the project administrator to the project 
list page to view all Checked-In projects.  From there, you can 
choose the project you would like to access. 

 Print Reports:  Gives the project administrator access to the Reports 
Window and the ability to build reports.   

 Print Project Information:  Prints out basic information about a 
given project.   

 Print Browser:  Prints the browser window in the middle of the 
screen. 

 Export:  Provides options for exporting multiple types of data in 
multiple formats.   

 Exit:  Closes The Concept System®.   

 

Project Menu   

 Create Focus Statement:  Allows the project administrator to create 
the focus statement that will be used to generate the brainstorming 
responses.   

 Set Participant Questions:  Allows the project administrator to 
create participant questions.  These are often demographic 
questions and can be used in subgroup comparisons of sorting and 
rating data.   
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 Create Users:  Gives the project administrator the ability to create 
users in The Concept System®.   

 Set Rating Scale:  Allows the project administrator to create the 
rating question(s) and scale(s).   

 Assign Sorts:  Gives the project administrator the ability to assign 
participants to the sorting activity.   

 Assign Ratings:  Gives the project administrator the ability to assign 
participants to the rating activity.   

 

Admin Menu   

 Enter Statements:  Allows the administrator to enter statements that 
have been gathered in response to the focus prompt.   

 Enter User Data:  Gives administrator access to entering sorting, 
rating, and participant question data.   

 Prepare Maps:  Allows the administrator to select the sorters to be 
included in the map and the ability to adjust map filters.   

 Setup Wizard:  Assists the administrator with the initial steps of 
setting up a project.   

 

View Menu   

 Concept Maps:  Displays options and settings for drawing different 
types of maps.   

 Pattern Match:  Gives the administrator access to constructing 
pattern matches and go-zones to compare participants’ rating 
results.   

 Go-zones:  Gives the administrator access to constructing pattern 
matches and go-zones to compare participants’ rating results.    

 Project Log:  Displays a searchable listing of data entry events that 
have taken place during the project.   

 Full Screen:  Maximizes the main Concept System window.   
 
 
 



 
The Concept System® Software Guide, v4.0.175           13 

Help Menu   

 Contents:  Displays a listing of Help Topics.   
 Index:  Displays a listing of the major topic areas in the 

help system.  The “Main Form” item on the list allows the 
administrator to display more detailed information about specific 
aspects of The Concept System® and concept mapping.   

 Search:  Allows the administrator to search the Help System by 
keyword.   

 Help Guide:  Contains information needed to use the application. 
 About Concept Systems:  Provides software version information as 

well as vendor contact information.   
 

Enter Focus Statement 

(Project-->Create Focus Statement) 
 
To add or modify the brainstorming focus statement for your project: 

1. Enter, or modify, the focus statement directly in the text box 
provided.  When you’ve finished, click Done. The focus statement is 
saved automatically.   

 

Create Users 

(Project-->Create Users) 

The Create Users option is used to create users, delete users, and to change 
usernames and passwords.   
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Figure 4. Example of the Create Users screen. 

 
To add new users to your project:   

1. To create a new user, click Add New User.   
2. Type in a username (the username must be at least 4 alpha/numeric 

characters; no spaces or symbols) and press Tab. 
3. Although the project administrator is the only user to access the 

software, a password must be entered for each participant.  
Passwords must be 6-16 characters. 

 
To delete a user from the project:   

1. To delete a user, select the user by clicking on the box to the left of 
the username (an arrow will appear in the box once you click it to 
indicate that you have selected this user).   

2. Click Delete User.   
 

Note:  If there is already data from this user in your project, the program 
will notify you that you cannot delete the user. 
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To change a username or password:   
1. Find the user’s record in the list of existing users on the Create Users 

screen.   
2. Click on the cell of the grid for that user for the item you wish to 

change.  Be sure the correct cell is shown as selected. 
3. Type the new value for the username, password, or other 

information.   
4. Click the Save User button to save the changes.   

 

Create Participant Questions    

(Project-->Set Participant Questions) 
 
Participant Questions can be used to describe characteristics of your users.  
These can also be called respondent or demographic questions.  The 
participant questions are essential for comparing subgroups using the 
pattern matches and go-zones feature of The Concept System®.  All 
participant question variables are created, modified or deleted from this 
screen.   
 

 
Figure 5.  Example of the User Demographics screen. 
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To add a new participant question variable to a project: 
1. Click on the Add button. 
2. Enter a name for the new user question variable, such as “Position” 

or “Age.” 
3. Enter an instruction, or prompt, for the user, such as “Select your 

position within the company” or “Enter your age.” 
4. Select either the Categorical or Continuous tab at the right. 
5. Enter possible values for the variable: 

 For Categorical variables, enter the category values one at a time.  
Click append after entering each category.   

 For Continuous variables, enter the minimum and maximum 
values (must be numeric values). 

6. Click Apply to save the question, (the new question will appear in 
the Name Select box at the top of the screen).  Click Add to create 
another Participant Question or OK to close the Participant Question 
window.   
 

To delete an existing participant question variable: 
1. Select the question name from the drop down box at the top of the 

screen. 
2. Click the Delete button. 
3. Click OK when the confirmation box pops up.  

 

 Note:  You cannot delete a variable after users have entered data for it. 

 
To modify an existing participant question variable: 

1. Select the question name from the drop down box at the top of the 
screen. 

2. Click in the text box of the item you want to modify, and make the 
change(s). 

3. Click OK to save change(s). 
 
To modify the values of an existing participant question variable: 

1. Select the question name from the drop down box at the top of the 
screen. 

2. Change the values: 
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 For a Categorical variable, click the value in the list to bring it up 
to the input box for typing.  Click in the input box and make the 
change.   

 For a Continuous variable, click in the Minimum or Maximum 
values box and make the change. 

3. Click OK to save change(s).   

 

Note:  If you need to change the type (i.e., Continuous or Categorical) of a 
participant question variable, simply delete the question and add it again 
with the desired changes. 

 

Set Rating Question and Scale Information 

(Project-->Set Rating Scale) 

 
Concept Mapping projects include one or more rating question.  Each 
brainstormed idea, or statement, can be measured on a specific rating scale 
for each rating question.   
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Figure 6.  Example of a Create Ratings screen. 

 
To add a rating question to your project: 

1. From the Ratings menu choose Add, or click the Add button. 
2. Enter the rating name, such as “Importance.” 
3. Enter an instruction, or prompt, for the user, such as “Rate the 

Relative Importance of the Brainstormed Ideas from 1 to 5.”   
4. Enter Minimum and Maximum values, such as 1 and 5. 
5. Enter labels for Minimum and Maximum, such as “Relatively 

Unimportant” and “Extremely Important.” 
6. Click Add to add another Rating Question, or Done to exit.   

 
To modify a rating question: 

1. Select the rating from the Rating List drop down box. 
2. Edit any of the information already entered. 
3. Click Done. 
 

To delete a rating question: 
1. Select the rating from the Rating List drop down box. 
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2. From the Ratings menu, choose Delete or click on the Delete button. 
3. A popup will ask if you are sure you want to delete the rating.  Click 

Yes.   
4. Click Done.   

 

Note:  A rating question cannot be deleted once there is rating data 
associated with it.   

 

Assign Sorts and Ratings to Users 

(Project-->Assign Sorts 
Project-->Assign Ratings)   
 
The Assign Sorts and Assign Ratings screens allow the administrator to 
assign users to sort and rate.   
 
(Project-->Assign Sorts)  The Concept System® allows the administrator to 
choose which participants will be involved in sorting the data.   
 

 
Figure 7.  Example of an Assign Sorts screen. 
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To assign users to sorts: 

1. In the Users box, click on the name(s) of the users you want to assign 
to sort. 

2. Click on the arrow pointing right, toward the Users Assigned box.  
The user’s name should appear in the Users Assigned box. 

3. Click Done.   
 

Note:  To quickly select all users, click the Select All button. 
To “un-assign” a user from sorting, simply select the user from the Users 
Assigned box and click on the left pointing arrow.  You cannot un-assign a 
user who has sorting data associated with him/her.   

 
(Project-->Assign Ratings)  The Concept System® allows the administrator 
to choose which participants will be involved in rating the statements.  After 
setting up the rating question(s) information, you are ready to assign the 
users who will be using the question(s) to rate. 

 

 
Figure 8.  Example of an Assign Ratings screen. 
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To assign users to rating question(s): 

1. Select the first rating scale you want to assign from the drop down 
box at the top of the window. 

2. In the Users box, click on the name(s) of the users whom you wish to 
rate according to this question.   

3. Click the arrow pointing right (or “greater than” sign) toward the 
Users Assigned box.  The user’s name should appear in the Users 
Assigned box. 

4. Select the next rating you wish to assign and follow the same 
procedure. 

5. Click Done when you have completed assigning users to rate.   
 

Note:  To quickly select all users, click the Select All button. 
To “un-assign” a user from a rating scale, select the user from the Users 
Assigned box and click on the left pointing arrow.  You cannot un-assign a 
user that has rating data associated with him/her.   

 

Exiting The Concept System® 

Click File-->Exit to exit The Concept System® Program.   
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2.  Generate Ideas 

Admin Menu 

The Admin Menu allows the project administrator to enter  
statements and user data, prepare maps, and access the setup wizard.   
 

 
Figure 9.  Example of the Statements Window. 

 
Enter and Edit Statements   

 (Admin-->Enter Statements)   

 
Statements can be collected in a number of ways.  They can be entered into 
the program during a live brainstorming session; submitted (on paper) by 
participants and entered into the program by the Administrator, or 
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imported into The Concept System® from a Text (.txt) file.   
 
For Administrators to enter a statement: 

1. From the Main Screen, click on the Statements button, or choose 
Admin-->Enter Statements. 

2. Click Add New Statement.  Enter the new statement in the box below 
the last statement currently listed inside the white Statement Entry 
box.   

3. Type in the new statement and press Enter. 
4. Once statement entry is complete, click Done.   

 
To edit a statement: 

1. Use the scroll bar to the right of the statement list to locate the 
desired statement. 

2. Click on the statement you would like to edit. The statement set 
must be unlocked to be editable. Make the desired changes to the 
statement and press Enter.  Your changes are automatically saved. 
 

To delete a statement:   
1. Click on the statement that you want to delete.   
2. Click Delete.   

 

Note:  Once there is sorting and/or rating data, statements cannot be 
deleted from a project.   

  
To change the fonts for the focus statement or statement list: 

1. Choose the Format-->Fonts menu, and select the element (focus 
statement or statement list) that you would like to edit. You will be 
presented with a standard Windows font dialog box which allows 
you to make your selection(s).   

 

Import/Export Statements 

(Admin-->Enter Statements) 

 
If the statement list exists as a word processing document (outside of The 
Concept System®), project administrators can import statements from a text 
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file (.txt) such as Microsoft Notepad®.  If the text file is formatted correctly -- 
one statement per line (click Return or Enter at the end of each statement) -- 
you can follow the instructions below.   
 
To import statements from an external text file: 

1. From the Main Screen, click on the Statements button, or choose the 
Admin-->Enter Statements Menu. 

2. From the File menu, choose Import Statements. 
3. Navigate to the text file containing the statements and select it.  (The 

file must be a .txt file and can only have one statement per line).   
4. Select how statements will be imported: 

 Click on “YES” if you want the text file statements to be 
appended to the end of the current statements. 

 Click on “NO” if you want the text file statements to replace the 
current statements.   

 Click on “Cancel” to stop the statement import.   
 

To export statements into an external text file: 
1. From the Main Screen, click on the Statements button, or choose 

Admin-->Enter Statements. 
2. From the File menu, choose Export Statements. 
3. Enter a name for the text file and select the location to save it.   
4. Click Save.   

 

Lock/Unlock Statements 

(Admin-->Enter Statements)  From the Statements Screen select 
(Statements Menu-->Lock/Unlock Statements). 
 
Before statements can be sorted or rated, they must be locked by the 
administrator.  If the administrator needs to go back to edit a statement 
(e.g., to correct a typing or spelling mistake, or to spell out an acronym, etc.), 
the statement set can be unlocked briefly to make the necessary edits. 
Remember to lock the statement set once it is finalized. 
 

Note:  Once sorting and/or rating data has been entered into the 
system, statements cannot be deleted from a project. 
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You may lock/unlock the statements at any time.   
 
To lock or unlock statements: 

1. From the Statements Menu on the Statements Screen, choose 
Lock/Unlock Statements (If the statements are currently unlocked, 
the menu will say ‘Lock Statements.’  If they are currently locked, it 
will say ‘Unlock Statements.’) 

 

Enter/Edit User Contact Info   

(Admin-->Enter User Data) 
 
User contact information in The Concept System® is optional; the 
Administrator can decide whether or not to collect such information.  Once 
User Contact Information is entered, it can be edited from the Admin menu.   
 
To enter or edit user contact information: 

1. Select the user information that needs to be edited from the list of 
users on the left side of the window.   

2. Click User Information to view the user’s personal information.  
Click inside any field to enter or change information.  Passwords can 
also be changed from this screen.   

 

Note:  You can delete a user from the Create Users screen (Project --> Create 
Users) by selecting the row of the user name and clicking on the Delete User 
button.  An administrator can only do this before data has been entered for 
that user.   

 

Enter/Edit User Demographics  (Participant Questions)   

(Admin-->Enter User Data)   
 
The administrator can edit each User’s demographic information from the 
Enter/Edit User Data screen.  Demographic variables are defined by the 
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administrator. 
 

 
To enter or edit user demographic information: 

1. In the Enter/Edit User Data window, select the correct user from 
the list of all users on the left, and click Participant Questions.  This 
enables the administrator to enter the participant question 
responses for each user.   

2. For Categorical variables such as position within the company, 
select a value from the list box. 

3. For Continuous variables such as age, enter a numeric value in the 
text box. 

4. Click on the Next and Back buttons to navigate through the 
demographic variables. 

 
When you have completed all demographics for that user, click Close.   
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3. Structure Ideas 
 

Participants may use sort cards and rating forms to record 
their sorting information.  The administrator would enter the 
submitted paper-based data into the program.   
 

Enter Sorts from Cards 

(Admin-->Enter User Data-->Manual Sort) 
 
After participants have sorted the statement cards and entered their results 
on the sort recording form, the administrator may enter the sort data into 
the program.   
 
 To enter sort data from sort recording forms: 

1. Select the Admin-->Enter User Data menu. 
2. Select a name from the List of all Users on the left side of your 

screen.   
3. Click on the Manual Sort button.  (If the person was not assigned to 

do a sort, this button will not be active.  See Assign Sorts and 
Ratings).  You will see something similar to the 
following screen:     __ 
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Figure 10.  Example of Sort for User screen.   

 
To start a new pile: 

1. Click the New button to create a new category.   
2. Enter a new category name and click OK.   
3. Enter the statements for the current pile.   

Enter the statement ID numbers in the Statement Number text box.  
As you enter each statement number, you will see the statement 
appear in the Category box.  Alternatively, you can use the left and 
right arrows in the middle of your screen to move a statement into 
or out of a category.   
 

To remove a statement from a pile: 
1. Click on the statement and then click the left arrow. You may also 

double-click on the statement to remove it from the pile.   
 

To change to a different category to move statements, rename, or 
delete: 

1. Select the category from the Category drop-down list. 
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To rename a category: 
1. Select the category you want to rename from the Category drop-

down list. 
2. Click Rename.   
3. Enter the new name in the text box and click OK.   
 

To delete a category:   
1. Select the category you want to delete from the Category drop-down 

list. 
2. Click Delete.  You will be asked if you are sure you want to delete the 

pile.  Click Yes.  Any statements in the pile are returned to your 
unsorted statements list.   

 
When you have finished entering a participant’s sort data into the program, 
you must mark it “complete” for it to be included in your analysis.   
 
To mark a sort as complete or incomplete:   

1. When you are finished sorting all statements into piles, check the 
“Sort Complete Box” on the top left of the screen. 

2. If you want to make changes after marking the sort complete, you 
may click on the ‘Sort Complete’ box, and the check will be removed.  
You may then change the sorting of statements.  You should mark 
the sort complete again when you are finished making changes or 
you will not be able to use this user’s sort data in any data analysis. 

 
To exit manual sorting, click Close.   
 

Note:  The sorting is automatically saved as the user completes it. 

 

Complete Sort  

Before sort data for a user can be used in computing a map it needs to be 
checked by the administrator and marked as complete.   
 
The administrator should review the sort data to be sure the user completed 
the sort properly before allowing the compute map analysis to process the 
data. 
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As the administrator, if you try to mark complete a sort that still has 
unsorted statements, you will get a message saying that the sort is not 
complete and ask if you want all remaining statements to be placed into 
separate categories.  Statements that are placed in separate categories are in 
effect treated as missing data in the analysis.  The program will 
automatically take care of this function if the administrator answers 
affirmatively.  Categories that are not conceptually related (e.g. 
“Miscellaneous” or “General”) should be separated into individual statement 
piles. 
 

Note:  For a sort to be used in the analysis, the total number of unsorted 
statements must be less than 25% of the total number of statements. 

 

Note:  After a sort is completed, it cannot be modified unless the 
administrator first turns the completed sort status off. 

 

Enter Ratings 

(Admin-->Enter User Data) 

 
Select the user that you want to enter rating data for, select the correct 
rating question, and click Enter Rating.  Users can be assigned one or more 
rating scales at any time during a project (see Assign Sorts and Ratings).   
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Figure 11. Example of the Enter Ratings Screen 

 
Entering a user’s rating information into The Concept System®: 

1. If more than one rating scale has been assigned, select a rating scale 
from the box that displays the ratings.  Click Enter Rating.  The 
Rating window will open automatically.   

2. Use the left and right arrow keys to navigate through the statements, 
or use your mouse to click the arrows on the screen.   

3. Enter the rating value for each statement, pressing the Right Arrow 
key or the Enter key after each value to navigate to the next 
statement. 

4. When ratings have been completed for a particular rating scale, the 
rating data needs to be reviewed by the administrator and checked 
as complete.  (See Complete Rating).   

 

 



 
The Concept System® Software Guide, v4.0.175           32 

Complete Rating 

(Admin-->Enter User Data) 

 
Before rating data can be used for analysis, drawing maps, etc., it needs to be 
marked complete. Each rating a user does must be reviewed and marked as 
complete before it can be used in map, pattern match, or go-zone analyses.  
As with sorting, the administrator will need to review rating data before 
allowing it to be used in the maps or matches. Doing so will help compile 
accurate data for later analyses. 
 
To complete a rating or to mark it incomplete:   
 

1. From The Concept System® Main Screen, select the Admin-->Enter 
User Data Menu.   

2. Click on the Username for the user in the list box on the left of the 
screen. 

3. If the User was assigned to do ratings, the rating information for that 
user will be active. 

4. Select the rating you want in the rating list box. 
5. Click on the ‘Completed’ check box to make sure it is checked.  The 

program will automatically take you into the rating window. 
6. Select the Rating-->Rating Completed menu.   
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4.  Prepare Maps 

Mapping Menu 

The Mapping Menu allows Administrators to compute 
maps. 
 

 

Select Sorts for Mapping 

(Admin-->Prepare Maps) 

 
A concept map can be drawn from any subset of at least 10 completed sorts, 
but it is recommended to have 15-30 completed sorts.  For example: you 
may want to view a concept map that includes sorts from only a certain 
subgroup of the users. 

To select user sorts: 

1. To select one user: just click on the name.   
2. To select a contiguous group of users: click and drag your cursor 

down the list. 
3. To select/deselect multiple users anywhere in the list: use 

CTRL-click for each. 

4. To select or deselect all users: click on the ‘Select All’ or ‘Deselect 
All’ buttons below the Users box.  You may select all users by clicking 
“Select All.” 

To select sorts based on user demographic variables: 

1. In the Condition 1 section, select a demographic variable from the 
select box on the left. 

2. Select an operator (=, <, >, etc.) from the middle select box. 
3. Enter search value:   

 If the variable is Continuous (i.e., shoe size), type in the search 
value in the box on the right.   
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 If the variable is Categorical (i.e., Employment level), select a 
value from the box on the right. 

4. Click on the Select Users button.  (Names of users whose 
demographic information matches the selected condition will be 
highlighted).   

 

Example:  If you want to select all users who are at the manager level within 
the company, select the “Level” demographic variable, the “=” operator, and 
the “Manager” value.  Condition 1 would then appear as “Level = Manager.”    

 
To select users based on two demographic variables or conditions: 

1. Enter Condition 1 as explained above. 
2. Select option for Condition 2 (below Condition 1 section): 

 To select users whose demographic information meets the first 
and second conditions select the AND option. 

 To select users that meet one condition or the other, select the 
OR option. 

3. Enter Condition 2 in the same way as Condition 1. 
4. Click on the Select Users button.  (Names of users whose 

demographic information matches the selected condition will be 
highlighted.   

 
 

Example:  For an OR condition:  To select all of the Managers or all users 
who have been with the company for more than 5 years, select “Level” 
variable, the “=” operator, and “Manager” value for Condition1. Click on OR. 
Then select the “Years” variable, the “>” operator, and put “5” in the box for 
Condition 2 (note that you want to use the OR button because you want 
users who are either Managers OR have been with the company more than 5 
years).   
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Select Mapping Options 

(Admin-->Prepare Maps)   

 

Figure 12. Example of the Prepare Map Window. 

The mapping options control how the sort data are aggregated.  You have 
two filtering options: 

Filter Method (Select one of the following): 

1. No filter (the default).  The data are aggregated as described in 
Constructing the Input (in the Help Guide within the Core 
Software).   

2. Specify similarity cutoff.  The value that you specify in the similarity 
cutoff box is applied to the final total similarity matrix.  Essentially, 
values in the similarity matrix at or below the cutoff value are set to 
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zero for the analysis.  If you specify a value of 2, this means that if 
only 2 or fewer users placed two statements together in a pile, the 
analysis will treat it as though no users placed the statements 
together.  This effectively filters out spurious relationships between 
statements.  In a project where the subject matter is very ambiguous 
or where you suspect that there is a lot of noise in the sorts; you 
might try re-computing maps with a cutoff value of 1 or 2.  It would 
be extremely rare to use a cutoff value greater than 2, unless you 
have a large number of available sorts for the analysis. 

Run Map Analysis 

(Admin-->Prepare Maps)   

To run the map analysis:  

1. Select sorts for mapping.   

2. Select Filter Method.   

3. Click on the Run Analysis button.   

After the analysis is completed, you will see the final stress value displayed 
in the text box at the bottom of the window.   
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5.  Create and Interpret Maps 
 

To work with maps, select the Concept Map button on The 
Concept System® Main Screen (or the View-->Concept Maps 
menu).  There are a wide variety of ways you can interact 

with concept maps. 

 

Create Map 

(View-->Concept Maps) 

Once the administrator runs the analysis (prepare map), 
he/she may create a map from the analysis.   

To create a map: 
1. Select Rating Information for the Map. 
2. Select Number of Clusters for the Map (this is necessary for any of 

the Cluster Maps). 
3. Set Map Specifications and Draw the Map. 

 

Select Rating Information for Map 

(View-->Concept Maps) 
 
Before drawing a map that reflects rating data, you will need to select the 
ratings you wish to include in the map.   
 
To select rating information for the concept map: 

1. At The Concept System® Main Screen, click on the Concept Map 
button, or go to the View menu and select “Concept Maps.”   

2. Click on the Select Ratings tab.   
3. If more than one rating scale has been defined for the project, select 

a rating scale from the Select Rating box.   
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4. Select which users’ ratings you wish to include.  You can select all, 
deselect all, manually select users, or select users by participant 
questions.  (See Selecting Usernames or Selecting Users by 
Demographics).   

 

Select Number of Clusters 

(View-->Concept Maps) 
 
Administrators have the option of changing the number of clusters for maps.  
Exploring and becoming familiar with the maps will help you determine the 
number of clusters that best represents the concept map. 
 
To select the number of clusters for a map: 

 Select one of the Cluster Maps in the lower dropdown box to make 
the select number of clusters box editable.   

 Click on the up or down arrow in the Number of Clusters box on the 
Map Settings Tab.    

 
The Map Settings tab allows you to customize the appearance of your maps.  
From this screen you may specify a wide variety of maps and map 
combinations.  For instance, you may simultaneously display any point map 
and any cluster map. The Map Settings Tab will look like this: 
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Figure 13.  Example of Draw Maps Specifications screen. 

 
To set specifications for drawing a map: 

1. Click on the Map Settings tab. 
2. Specify point map information using Point Map options: 

 Point Map Type:  from the Point Map Select box, select Point 
Map, Point Rating Map, or Point Bridging Map.  In order to do a 
Point Rating Map, you must first select the ratings you want to 
include.  The Point Rating and Point Bridging maps allow you 
to optionally select whether you want a legend for the rating or 
bridging layers. 

 Point Map Font:  to change the font of statement numbers, 
type the desired font into the font text box or click Change Font.   

 Point Fill Color:  to change the color of points on the map, click 
on the Change Color button. 

 Border:  to change the Point Border Color, Select the Change 
Border Color button.   
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 Change Font Size:  to change the size of the font of your point 
numbers, select the Change Font Size button.   

 Statement Numbers:  to include the statement numbers on 
the Point Map, check the Statement Numbers On option.   

 Point Legend:  to add a point legend to point rating or point 
bridging maps, check the Point Legend On option.   

 Maintain Proportions:  to maintain map proportions, check 
Maintain Proportions.   

 Draw Map Border:  to draw a border around your map, check 
the Draw Map Border box.   

 
3. Specify cluster map information using Cluster Map options: 

 Cluster Map Type:  from the Map Type select box, select 
Cluster Map, Cluster Rating Map, Cluster Bridging Map, or 
Cluster Replay Map.  To do a Cluster Rating Map you must first 
select the ratings you want to include.  The Cluster Rating and 
Cluster Bridging maps allow you to optionally select whether 
you want a legend for the rating or bridging layers.  If you 
select Cluster Replay Map you will need to specify the range of 
cluster solutions you want to replay.  For instance, if you want 
to replay the cluster analysis from 20 clusters down to 5, type 
20 and 5 in the appropriate boxes after selecting Cluster Replay 
Map as shown below:  

 

 Cluster Fill Color:  to change the color of clusters on the map, 
click on the Change Color button.   

 Cluster Border:  to change the cluster border color, select the 
Change Color button to the right of “Border.”   

 Cluster Map Font:  to change your cluster map font, type in the 
desired font in the text box.   

 Font Size:  to change the font size of cluster labels, click on the 
Change Font button.   
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 Number of Clusters:  to change the number of clusters on the 
map, click on the up or down arrow in the Number of Clusters 
box. 

 Cluster Numbers:  to include the cluster numbers on the map, 
check the Display Cluster Numbers option. 

 Cluster Labels:  to include the automatically generated cluster 
labels, check the Display Cluster Labels option. 

 Same Colors as Pattern Match:  to draw your clusters in the 
same colors that are used to draw pattern matches, select this 
option.   

 Display Border:  to draw a border around the map, select this 
option.   

 Smooth Cluster Shape:  to smooth the edges of the cluster 
shapes on your map, select this option.   

 Show Legend:  to include a legend for the cluster map, check 
this option. 

 
When you have selected all the options you desire and customized the map 
specifications, click on the Draw Map button to draw a map. 

 

Note:  If you want to view the map only as a Point Map, select None from 
the Map Type box in the Cluster Map section. If you want to view the map 
only as a Cluster Map, select None from the Map Type box in the Point Map 
section. 

 
Save Map  

Once you have created your concept map you will be able to save the map 
from the map viewing window.  Only one version of the map may be saved 
at one time.  During the Compute Maps step, the project administrator 
explores different map options and saves the “best” map.  The map is saved 
to the database to be accessed later in the Interpret Maps step.   

A saved map is accessed through the following steps:   
(View-->Concept Maps, maintain current map settings and click Draw Map).   



 
The Concept System® Software Guide, v4.0.175           42 

Note:  You must save a map before you can create pattern matches or go-
zones. 

 

To save a map:   
1. To save a map you first have to draw it.  See Set Map Specifications 

(above) for how to draw a map.  When you see the map on the 
screen, choose Save Map from the Maps menu.   

2. The current map is automatically saved to the database.  (Use “Load 
Map” to retrieve your saved map.)   

Note:  The Concept System® can only save one map at a time.   

 

Copy Map (Print) 

(Mapping-->Draw Map) 

 
A map can be copied to the clipboard and pasted into another application.  
For example, you can copy a map and paste it into any presentation software 
such as Microsoft PowerPoint for fine-tuning and printing. 

To copy a map:   
1. To copy a map you first have to draw it.  See Set Map Specifications 

(above) for how to draw a map.  When you see the map on the 
screen, choose Copy Map from the Draw Maps menu. 

2. The current map will be copied on to your computer’s clipboard.   

3. Open the application (word processor, graphics, presentation 
software, etc.) you will be working with and paste and save the map.  
You will then be able to print from this file. 

4. Repeat the previous process to build a file of maps in other 
applications for complete documentation or for a presentation.   

To print a map:   
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 To print a map, go to the Maps menu on the map display window 
and select Print Map B&W or Print Map Color.   

 
Load Map 

(View-->Concept Maps)   

The most recently saved map can be loaded and viewed by the project 
administrator. 

To load a map: 

1. From the Map Settings Tab, click the Draw Map button.   

2. Once the Map is displayed, go to the Maps Menu.  Click on Load Map.     

3. This will return you to the Map Settings Tab to show you the current 
settings of the saved map you are loading.  Select Draw Map to view 
the saved map.   

 

Interact with Map 

(View-->Concept Maps-->Click Draw Map) 

 
To explore the maps in more detail, move the mouse over a point or a 
cluster and click on the right mouse button (or use the keyboard 
equivalents shown below).  Hovering over a point on the map will display 
the statement text.  A popup menu allows the following options: 

1. Category Labels:  Shows the top ten category labels produced by 
your participants.  You can change your cluster labels from this 
window.   

2. Cluster Statements:  Shows all statements within the selected 
cluster.  You can change your cluster labels from this window.   

3. Find Closest Statements:  Will locate the closest points from the 
pixel location where you clicked your mouse cursor on the screen.   

4. Run Spanning Analysis:  Shows how frequently points on the map 
have been sorted together.   
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5. Deactivate Spanning Analysis: Removes the displayed spanning 
analysis.   

6. Redraw Cluster Boundaries:  Allows you to redraw a cluster 
boundary to include a point that was previously in another cluster 
(see below).   

 

 
Figure 14 .  Example of right mouse click options. 

Moving a Statement from One Cluster to Another 

When a statement on a map qualitatively seems to belong in a cluster 
adjacent to the one it is in, you can change its cluster by directly 
manipulating the data in the database.  This does not actually move the 
location of the statement, but redraws the cluster boundaries to include the 
statement in a different cluster.   
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Moving a statement into another cluster: 
 
(View-->Concept Maps)   
 

1. Draw a Point Map and Cluster Map simultaneously.  Check Statement 
Numbers On for the point map and Cluster Labels On for the cluster 
map. 

2. On the map, right-click on the statement number and select the 
Redraw Cluster Boundaries option in the popup menu.  You should 
see the ‘Now In Cluster’ label below the statement.   

3. Click on the down-arrow in the ‘Move To Cluster’ list box and select 
the name of the cluster you want to move the statement into. 

4. Click ‘Done’.  You will be asked if you are sure you want to move the 
statement.  Click ‘OK’.  The map will be re-drawn with the statement 
moved into the new cluster.  Save the map button to keep this 
cluster configuration. 

 

Changing the Name of a Cluster 

There may be times when the program is not selecting cluster labels that 
you feel are appropriate, or the best fit, for a particular cluster.  These labels 
can be changed manually on a map.  Follow the procedure below to change a 
cluster name.   
The cluster names that are saved in the Draw Maps window of a saved 
map are the ones that are automatically used in all pattern-matching 
displays.   
 

Note:  Only 1 map can be saved in the database at a time.  Every time you 
draw a new map with different names or number of clusters and save it, any 
previous changes are overwritten.  Save the map with the arrangement and 
cluster labels you wish to retain.   

 
Changing the name of a cluster from the cluster statement listing: 

1. In Map Settings, select a cluster map and draw it. 
2. While looking at the map, right-click on the cluster name you wish to 

change and select ‘Cluster Statements’ from the menu. 
3. In the cluster name box at the top of the window type in, or edit, the 

name.  When finished, hit the ‘Enter’ key or click on the Done button. 
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4. You will be asked if you are sure you want to change the name.  Click 
OK.  The name will be changed and the revised map will be 
displayed.  Save the map.   

 
You can also change the cluster name when you are looking at the ten best 
pile labels window.  This is an excellent way to review the appropriateness 
of the cluster names and select one of the alternative best ten names, or 
create your own, if you so desire.   
 
Changing the name of a cluster from the pile labels listing: 
 

1. In Map Settings, select a cluster map and draw it.   
2. While looking at the map, right-click on the cluster name you wish to 

change and select the ‘Category Labels’ menu item.   
3. In the list of the ten best labels, double-click on the label you prefer.  

It will be placed into the cluster name box at the top of the window.  
Alternatively, you can manually edit the cluster name. When 
finished, hit the ‘Enter’ key or click the ‘Done’ button. 

4. You will be asked if you are sure you want to change the name.  Click 
OK.  The name will be changed and the revised map will be 
displayed. 

5. Save the map to save the changes.   
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6.  Utilize Maps 

Matching Menu 

The Pattern Match screen allows Administrators to create 
pattern matches. 
To work with pattern matching, select the Pattern Matching 
button on The Concept System® Main Screen (or View--
>Pattern Match).  There are many ways to construct pattern 
matches. 

 

Create Pattern Match  

(View-->Pattern Match) 
 

Pattern Match ladder graphs can be created by the administrator once a 
concept map has been drawn and saved.   
 
To create a pattern match: 

1. Select Rating Information for the Pattern Match. 
2. Set Pattern Matching Specifications and Draw the Ladder Graph.   

 

Select Rating Information for Pattern Match 

(View-->Pattern Match) 

 
Before drawing a pattern match, you need to select the rating information 
you wish to include on the left and right sides of the pattern match ladder.  
You must select the rating and users separately for each side. 
 
To select rating information for the pattern match: 

1. If more than one rating scale has been defined for the project, select 
a rating scale from the Select Ratings box. 

2. Select Rating Information for the left side of the ladder graph.   
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 Enter the Left Side Label.  Please note that in order to create an 
Absolute Pattern Match you must draw a relative match first 
then enter the Minimum and Maximum Values for the left side.   

 Select which users’ ratings you wish to include on the left side 
(see below). 

3. Select Rating Information for the right side of the ladder graph 
 Enter the Right Side Label. Please note that in order to create an 

Absolute Pattern Match you must draw a relative match first 
then enter the Minimum and Maximum Values for the right side.   

 Select which users’ ratings you wish to include on the right side 
(see below).   
 

To select users for either side: 
 Follow the procedures to select usernames either manually or by 

demographic group (see Selecting Usernames Manually or by 
Demographics). 

 
Set Pattern Matching Specifications 

(View-->Pattern Match) 
 
Before a pattern matching ladder graph is created, you need to select the 
ratings and options you desire for the graph. 
 
To set pattern matching graph specifications: 

1. Select rating information for pattern match.   
2. Click the Draw Pattern Match button.   

To load a pattern match that was drawn previously: 
1. From the File menu on the Pattern Match build window, choose 

Load Graph.   
2. Click the Draw Pattern Match button. 

To save a pattern match to an external file or copy a pattern match: 
1. From the Pattern Matching Display window, select the File menu 

then choose Save Graph or Copy Graph.   
2. Your match settings are now saved in the system or have been 

copied and are ready to be pasted into another program such as 
Microsoft PowerPoint.   
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To view the Pattern Matching Correlation on a ladder graph: 
1. Click the Show Correlation check box. (This should be checked as the 

default setting).   
 

The pattern match specification screen looks like: 
 

 
Figure 15.  Example of Pattern Matching Specifications Screen 

Save Pattern Match  

(Pattern Matches & Go-Zones -->Draw Pattern Match) 

The project administrator can save a pattern match.  The pattern match is 
saved to the database to be accessed later.  A saved pattern match is 
accessed through the Load Graph option. 
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To save a pattern match: 
 

1. From the Displayed Pattern Match window, select File then Save 
Graph.  The current pattern match is saved to the project database. 

 

Copy Pattern Match (Print) 

(Pattern Matches & Go-Zones-->Draw Pattern Match) 
 
A pattern match ladder graph can be copied to the clipboard and pasted into 
another application.   
 

To copy a pattern match:   

1. From the Displayed Pattern Match window, select File then Copy 
Graph.  The current pattern match ladder graph is copied to the 
clipboard. 

2. Open another application (word processor or graphics) and paste 
the pattern match, then save it.  You can now fine-tune the map and 
print it.   

Load Pattern Match   

(View-->Pattern Match)   

 
A pattern match ladder graph that was saved previously can be loaded and 
viewed by users. 
 
To load a pattern match: 

1. From the File Menu, choose Load Graph.   

2. Click on the Draw Pattern Match button. 
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Figure 16.  Example of a Pattern Match.   

 

Create Go-Zone   

(View-->Go-Zone)   
 

Go-zones can be created by the project administrator once a concept map 
has been drawn and saved.   
 
To create a go-zone:   

1. Select Rating Information for the go-zone.   
2. Select your cluster or draw the go-zone with all clusters.   
3. Click the Draw Go-zone button.   
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Select Rating Information for Go-Zones   

(View-->Go-Zone) 
 
Before drawing a go-zone, you need to select the rating information you 
wish to include on the left and right sides of the Draw Go-Zones screen.  You 
must select the rating and users separately for each side. 
 
To select rating information for the go-zone:   

1. If more than one rating scale has been defined for the project, select 
a rating scale from the Select Ratings box. 

2. Select Rating Information for the X-Axis of the go-zone.   
 Enter the Left Side Label for the X-Axis.   
 Select which users’ ratings you wish to include on the X-Axis (see 

below). 
3. Select Rating Information for the Y-Axis of the go-zone.   

 Enter the Right Side Label for the Y-Axis.   
 Select which users’ ratings you wish to include on the Y-Axis (see 

below).   
 

 
To select users for either side: 

 Follow the procedures to select usernames either manually or by 
demographic group (see Selecting Usernames Manually or by 
Demographics).   

 

Set Go-Zone Specifications 

(View-->Go-Zone) 

 
Before a go-zone graph is created, you need to select the ratings and options 
you desire for the graph. 
 
To set go-zone graph specifications: 

1. Select rating information for the go-zone.   
2. Click the Go-Zone button.   

To load a go-zone that was drawn previously: 
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1. From the File menu on the go-zone build window, choose Load 
Graph.   

2. Click the Draw Go-Zone button. 
To save a go-zone to an external file, or to copy a go-zone: 

1. From the Go-Zone Display window, select the File menu then choose 
Save Graph or Copy Graph.   

2. Your go-zone settings are now saved in the system or have been 
copied and are ready to be pasted into another program such as 
Microsoft PowerPoint.   

To Show X,Y averages for each point on the go-zone:   
 Click the Show X,Y averages for each point check box.   

To Shade Grid Background:   
 Click the Shade Grid Background check box.   

To Color Statements by Cluster:   
 Click the Color Statements by Cluster check box.   

To Show Go-Zone Dividers:   
 Click the Go-Zone Dividers check box.  (This should be checked as 

the default setting).   
To Show Axes Headings:   

 Click the Show Axes Headings check box.  (This should be checked as 
the default setting).   

To Draw Map Border:   
 Click the Draw Map Border check box.   
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The Go-Zone specification screen looks like:   
 

 
Figure 17.  Example of Go-Zone Specifications Screen 

 

File Menu of a Displayed Go-Zone   

Save Go-Zone  

(Pattern Matches & Go-Zones-->Draw Go-Zone) 

The project administrator can save a go-zone.  The graph is saved to the 
database to be accessed later.  A saved graph is accessed through the Load 
Graph option. 
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To save a go-zone: 
 

2. From the Displayed Go-Zone window, select File then Save Graph.  
The current go-zone is saved to the project database. 

 

Copy or Print a Go-Zone   

(Pattern Matches & Go-Zones-->Draw Go-Zone) 
 
A go-zone graph can be copied to the Windows clipboard and pasted into 
another application.   
 
To copy a go-zone: 

1. From the Displayed Go-Zone window, select File then Copy Graph.  
The current go-zone graph is copied to the clipboard. 

2. Open another application (word processor or graphics) and paste 
the go-zone; then save it.  Now you can fine-tune the map and print 
it.   

To print a go-zone:   
1. From the Displayed Go-Zone window, select File then Print Graph 

(Color) or Print Graph (B&W).   
2. Select the printer you want to print to and click Print.   

To save as bit-map file:   
1. From the Displayed Go-Zone window, select File then Save as bit-

map file.   
2. In the Windows save as window, enter the file name for the saved 

go-zone, select the location to save the file, and click Save.   

To find a statement:   
1. From the Displayed Go-Zone window, select File then Find 

Statement.   
2. Use the Dropdown boxes to select the statement or cluster you are 

trying to find.   
3. Click Find.   
4. The statement you are looking for will now appear on the go-zone in 

red.   
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5. To show the closest statement, select the statement from the 
dropdown box then click Show Closest.   

6. The program will generate a window showing the closest statements 
to the statement you selected based on the distance in pixels.   

 
To Export Statements & Zones:   

1. From the Displayed Go-Zone window, select Export Statements & 
Zones.   

2. In the Windows save as window, enter the file name for the exported 
file, select the location to save the file, and click Save.  

 
To Return to the Go-Zone Specification Screen:   

1. From the Displayed Go-Zone window, select File then Settings.  This 
will return you to the Go-Zone Specifications Screen and allow you 
to modify the displayed graph.   

 

To Exit the Graph:   

From the Displayed Go-Zone window, select File then Exit Graphs.   

 

Load Go-Zone   

(View-->Go-Zone) 
 
A go-zone graph that was saved previously can be loaded and viewed by 
users. 
 
 
To load a go-zone: 

1. From the File Menu, choose Load Graph.   
2. Click on the Draw Go-Zone button. 

 
 



 
The Concept System® Software Guide, v4.0.175           57 

3.461.6 5

2

4.8

Needs Assessment  

I
m

p
o
rt

a
n

c
e

3.2

1

2 3

4

5

6

7

8

9

10

11

12

13

14

15

16

17

18

19

20

21

22

23

24

25

2627 28

29

30

31

32

33

34

35

36

37

38

39

40

41

42

43

44

45 46

47

48

49

50

51

52

53

54

55

56

57

58

59

60
61

62

63

64

65

66

67

68

69

70

71

72

73

74

75

76

77
78

79

80

r = .5

 
 

Figure 18.  Example of a Go-Zone.   
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7. Reports   
 
The Concept System Software allows you to view, print 
and export reports from the Reports window.  Project 
Administrators can utilize a variety of tables and lists 
including sort statement cards, rating sheets, statements 
sorted by cluster, and other customized lists of concept 

mapping data.   
 

 

Figure 19.  Example of the Choose Reports Tab in the Reports window. 

 
To Access a Report:   

1. Click the Reports Button in the top row of buttons on the main 
screen of The Concept System®.   

2. From the Reports window, select the type of report you want to 
print (Statement Cards, Rating Sheets, etc.)   
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3. Click View Report or Continue if additional Rating, User, or Cluster 
data information is needed.  Once the necessary information has 
been input, click View Report.   

 
From the View Report Window:   
The project administrator has the options to Print, Export, or Exit the report 
(by clicking Done).   

 
To Export a Report:   

1. Click Export at the bottom of the report display window.   
2. Select the appropriate file format of the report and click Export.   
3. In the Windows save window, select the file location to save the 

report and click Save.   
 
Reports:   

1. Sorted by Statement ID:  This report displays the Statements 
sorted by the Statement ID.   

2. Sorted by Rating – Ascending:  This report displays the statements 
sorted by a specified rating from the Select Rating tab in Ascending 
order.   

3. Sorted by Rating – Descending:  This report displays the 
statements sorted by a specified rating from the Select Rating tab in 
Descending order.   

4. Sorted by Bridging – Ascending:  This report displays the 
statements sorted by bridging values in Ascending order.   

5. Sorted by Bridging – Descending:  This report displays the 
statements sorted by bridging values in Descending order.   

6. Sort Cards Sheets:  Once the statement set has been finalized, the 
project administrator can produce sort cards directly through The 
Concept System®.   

 Sort Cards:  This report will generate your sort cards in 
numeric order with 10 cards displaying per sheet.   

 Sort Cards (Batch of 10):  This report will generate your sort 
cards with each sheet displaying 10 cards of the same 
statement.   

7. Rating Sheets for Manual Ratings:  This report will generate rating 
sheets for your participants to use in paper-based participation.   

8. All Rating Variables:  This report will display the rating questions 
and specifications for each rating question.   
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9. User List:  This report will generate a list of users, their user ID, and 
any personal information that was entered into The Concept 
System®.   

10. User Sort Report:  This report will display each user’s sort data.   
11. Cluster Labels with Average Ratings:  This report will display 

Cluster labels with their averaged ratings for the rating scale that is 
chosen.   

12. Cluster Statements with Average Ratings:  This report will 
display the statements by cluster with each statement’s average 
rating for the rating scale that is chosen.   

13. Cluster Statements with Summary Statistics:  This report will 
display the statements by cluster with each statement’s average 
rating for the rating scale that is chosen.  The report also displays 
the summary statistics for each cluster including a count of 
statements, standard deviation, variance, average, mean, minimum, 
and maximum for each cluster rating.   

14. Cluster Statements with Bridging Values:  This report will show 
the statements by cluster in ascending order by their bridging 
values.  The report also displays the summary statistics for each 
cluster including a count of statements, standard deviation, variance, 
average, mean, minimum, and maximum for the cluster bridging 
values.   

15. PQ Full List:  This report will display each participant question as 
well as the associated categories for responses.   

16. PQ Categories – No Charts:  This report will display each 
participant question categorical response, the number of 
participants that selected each category, and the percent of 
participants that selected each category.   

17. PQ Categories – charts (best for fewer categories):  This report will 
display each participant question categorical response, the number 
of participants that selected each category, and the percent of 
participants that selected each category.  This report also includes 
bar and pie charts to illustrate the participant question data.   

18. PQ Categories – charts (best for more categories):  This report will 
display each participant question categorical response, the number 
of participants that selected each category, and the percent of 
participants that selected each category.  This report also includes 
bar and pie charts to illustrate the participant question data.   
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19. PQ Continuous Variables:  This chart will display the results of 
each continuous participant question.  The results include the 
minimum and maximum set by the administrator, the count of 
responses, and the low and high values of the responses.  The report 
also displays the median, mode, average, standard deviation, and 
variance of the responses.  Additionally, the report displays a bar 
graph of the count of responses for each number in the range of 
responses.   
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8. Project Log Menu 
 

(View-->Project Log) 

 
The project log is a listing of the major events in a project.  Administrators 
can use it to help manage the project, keep track of major events, and review 
progress.  Each log entry tells the specific date and time, the Username, and 
the event. 
 

 
Figure 20.  Example of the Project Log Window.   

  


